Note
Before using this information and the product it supports, read the information in “Notices” on page 47.
Modify a Portal Section ........................................................................................................ ...................................11
Delete a Portal Section ........................................................................................................ ....................................11

Portals.........................................................................................................................................................12
Add a Portal..................................................................................................................................................12
Modify a Portal ..............................................................................................................................................14
Copy a Portal ..............................................................................................................................................15
Delete a Portal ..............................................................................................................................................15

Navigation Builder...........................................................................................................................................15
Access the Navigation Builder ......................................................................................................................16
Search for a Navigation Collection..............................................................................................................16

Navigation Collections...................................................................................................................................17
Add a Navigation Collection ..........................................................................................................................17
Modify a Navigation Collection ......................................................................................................................19
Copy a Navigation Collection ......................................................................................................................19
Delete a Navigation Collection ....................................................................................................................20
Group Overrides .............................................................................................................................................20

Navigation Items ..........................................................................................................................................21
Access the Navigation Items Library ...........................................................................................................21
Search for a Navigation Item ..........................................................................................................................22
Add a Navigation Item ..................................................................................................................................22
Modify a Navigation Item ..............................................................................................................................26
Copy a Navigation Item ..................................................................................................................................27
Delete a Navigation Item ..............................................................................................................................27
Add a Navigation Item to a Navigation Collection ......................................................................................27
Change the Arrangement of Navigation Items in a Navigation Collection ..................................................28
About This Guide

This guide describes how to use the tools in the IBM TRIRIGA Application Platform to customize the look and feel of the IBM TRIRIGA user experience, including the sign-in page, Portal Builder, Navigation Builder, Style Manager, and Style Sheet Editor.

Conventions

This document uses the following conventions to ensure that it is as easy to read and understand as possible:

- **Note** - A Note provides important information that you should know in addition to the standard details. Often, notes are used to make you aware of the results of actions.

- **Tip** - A Tip adds insightful information that may help you use the system better.

- **Attention** - An Attention notice indicates the possibility of damage to a program, device, system, or data.

Intended Audience

This guide is for Application Administrators and other users responsible for setting up and maintaining the IBM TRIRIGA applications.

Prerequisites

This guide assumes the reader has a basic understanding of Web-based applications and has administrator access to the IBM TRIRIGA software.

Support

IBM Software Support provides assistance with product defects, answering FAQs, and performing rediscovery. View the IBM Software Support site at [www.ibm.com/support](http://www.ibm.com/support).
1. Sign In Page

With the IBM TRIRIGA Application Platform you can personalize the IBM TRIRIGA sign-in page by changing the login image.

This feature also maintains support of the single sign-on (SSO) functionality. When SSO is enabled, the user is redirected to the IBM TRIRIGA application after login credentials have been validated. For information on configuring SSO, see the IBM TRIRIGA Application Platform 3 Single Sign-On Setup User Guide.

Change Image

The only image that can be replaced is in the login_image_175x175.png file. This file is copied from versions 3.2 and later when upgrading. The rest of the files are not copied over.

If you wish to customize your sign-in page, replace just that one image file or use the alternative login page, which can be fully customized. There you can use the template and html language to update it.

Alternate Sign In Page

The steps to create an alternate sign-in page include designing what the new sign-in page should look like, doing setup and configuration, and testing the result.

Design Alternate Sign In Page

After planning the design of your alternate sign-in page, use the template named index.html located in the alt directory in the IBM TRIRIGA userfiles folder to build it. An example of its location in Windows is C:\Tririga\userfiles\alt.

The index.html file allows you to quickly design and deploy your alternate sign-in page. It contains design elements that enable you to reuse the existing IBM TRIRIGA sign-in functionality.

The Readme.txt file contains further information about the template sign-in page and how to use it.

Setup and Configuration

Once you have designed your alternate sign-in page, you need to tell the system that an alternate sign-in page is available. Sign in to the Administrator Console and define the alternate sign-in properties in the TRIRIGAWEB.properties file. The Administrator Console is described in more detail in the IBM TRIRIGA Application Platform 3 Administrator Console User Guide.
To Specify Alternate Sign In Page in Administrator Console

**Step 1**  In the Managed Objects panel on the left side, select the radio button to the left of System Manager.

System Manager information displays in the right panel.

**Step 2**  In the Property Files section, click **Edit** on the IBM TRIRIGA Web line.

**Step 3**  Set the ALTERNATE_RESOURCE_DIRECTORY property to the directory that contains your alternate sign-in page. For example, the folder C:/Tririga/userfiles/alt.

**Step 4**  Set the ALTERNATE_INDEX_HTML property to the file name of your alternate sign-in page. This file must be located in the directory defined in the ALTERNATE_RESOURCE_DIRECTORY property. For example: index.html.

**Step 5**  Scroll to the bottom of the right panel and click **Save**.

**Step 6**  Select **Logout** in the left panel.

The settings take effect when you restart your Application Server.

To place the **Forgot Password** link on the login page, setup the login page to allow password change requests as shown below:

To Specify a Sign In Page for Password Change Requests

**Step 1**  Setup password change to guest user.

**Step 2**  Set the user portal to "Global - Password Reset Landing Page".

**Step 3**  Edit forgotPassword-index.html and set PASSWORD_RESET_ACCOUNT_LOGIN to the user and the PASSWORD_RESET_ACCOUNT_LOGIN_PASSWORD to the password.

**Step 4**  Edit TRIRIGAWEB.properties, and set the ALTERNATE_LOGIN settings to point to the forgotPassword-index.html directory and file.

Sign In to IBM TRIRIGA

When you launch IBM TRIRIGA, the alternate sign-in page appears. If you face any issues with this procedure, you must restart your application server or clear your browser cache.
2. IBM TRIRIGA Portal and Navigation

The IBM TRIRIGA portal is the central organizing element of the application user interface. All functionality in the product can be accessed through this interface. This chapter covers the components of the portal starting from the home page.

When a user signs in to the IBM TRIRIGA Application Platform, the first thing they see is their home page. A user can return to their home page at any time by clicking the Home menu item. The portal contains many elements that affect the user on a daily basis, as well as quick access to those items used most frequently. The following describes an example of a home page. Your home page might look different from the following example but the general appearance will be similar.

- **Welcome Bar** - Including “Welcome, Paul Planner” (a Space Planner role), Sign Out, Sitemap, Support, and Help links.
- **Company Logo** - Including the “IBM TRIRIGA” company logo, Company | Project Toggle, and Project Selector.
- **Menu Bar** - Including the Home, My Reports, Requests, and many other first-level menu items.
- **Page Title Bar** - Including the Home page title, Personalize link and My Bookmarks link.
- **Portal and Portal Sections** - A Space Planner home portal, including the following portal sections: (1) Reminders - Space Planner, (2) Performance Metrics - Space Planner, (3) Related Links - Space Planner, and (4) Portfolio - Supply/Demand.

Users in different roles use the IBM TRIRIGA application in different ways and need different portals. For descriptions of the components of a portal, examples of the as-delivered IBM TRIRIGA portals and portal sections, menus, and navigation tips, see the Getting Started videos in the Media Library at https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/IBM%20TRIRIGA1/page/Media+Library. For descriptions of the user roles, go to the IBM TRIRIGA Knowledge Center and select Getting started > Default user roles.

Any item selected in a menu is rendered in the content area. The user can choose to use standard browser controls to render the content in a new tab or new window. Using the browser controls is not equivalent to a pop out type of feature. The content opens in a new tab or new window but still contains the full IBM TRIRIGA window with its menu.

Switching the project context refreshes the main window, thus presenting a project-specific menu and home portal. The platform does not support managing multiple projects simultaneously within the same user session. The platform does not prevent a user from attempting to do this, but the user could run in to some undesirable behavior if they attempt this.

If a user views a form in the content area, a Cancel or Close action results in the user going “back” to the previous page.

Attention - It is recommended that you only build applications when logged in as an English user. If you choose to build applications on your own language, you will end up...
Portal Builder

Portals and portal sections are created and edited in the Portal Builder. The following sections describe how to use the Portal Builder. Assemble a library of portal sections before constructing your own portals.

- Portal Sections
- Portals

Access the Portal Builder

Follow the steps to access the Portal Builder tool.

To Access the Portal Builder

Step 1 Select Portal Builder from the Tools > Builder Tools menu or from the Tools - Application Builder portal section.

The system displays the Portal Builder page, which lists existing portals.

The actions on the top of the Portal Builder page are as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Add a new portal.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit the selected portal.</td>
</tr>
<tr>
<td>Copy</td>
<td>Create a portal containing the same portal configuration as the selected portal.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected portal.</td>
</tr>
</tbody>
</table>

Search for a Portal

The Portal Builder page has a search tool to help you find a portal.

To Search for a Portal

Step 1 Type the desired search text for the name of the portal and press the Enter key. The filter uses the Contains operator to display the portals that meet the criterion entered.
Portal Sections

Portal sections are the building blocks from which portals are constructed. Portal sections are displayed as encapsulated areas within a portal. IBM TRIRIGA ships hundreds of portal sections. These standard portal sections include system components that provide data and navigation help as well as action items, notifications, queries, adding a record, and viewing a record.

Portal sections are divided into two main categories: Portal section types you define and portal section types defined by the IBM TRIRIGA Application Platform.

The portal section types you can define are as follows:

<table>
<thead>
<tr>
<th>Portal Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Contains the results of any IBM TRIRIGA report, for example, graphic, chart, report, hierarchical.</td>
</tr>
<tr>
<td>External</td>
<td>Shows the contents of a specific URL.</td>
</tr>
<tr>
<td>Scorecard</td>
<td>Contains the result of a metric query measured against the data appropriate for the Workplace Performance Manager user role.</td>
</tr>
<tr>
<td>Quick Links</td>
<td>Displays a navigation collection of type Quick Links.</td>
</tr>
<tr>
<td>Form - Record Add</td>
<td>Shows a form for creating a record.</td>
</tr>
<tr>
<td>Form - Record View</td>
<td>Displays an existing record using its form.</td>
</tr>
</tbody>
</table>

Portal sections that are defined by the internal logic of the IBM TRIRIGA Application Platform are System portal sections. The following lists the System portal sections:

<table>
<thead>
<tr>
<th>System Portal Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysActionItems</td>
<td>Contains a list of the action items waiting for an action by the logged-in user.</td>
</tr>
<tr>
<td>sysLastVisited</td>
<td>Contains the last places the user has opened in the system.</td>
</tr>
<tr>
<td>sysNotifications</td>
<td>Displays a list of notifications that have been sent to the logged-in user and not deleted.</td>
</tr>
<tr>
<td>sysSelfService</td>
<td>Provides access to the Request Central menu.</td>
</tr>
</tbody>
</table>

The Portal Sections Library is the part of the IBM TRIRIGA Application Platform used to create, edit, and manage portal sections. Use the Portal Sections Library to create your own portal sections by adding additional portal section content to reflect the needs of your organization.
### Access the Portal Sections Library

Follow the steps to access the Portal Sections Library.

<table>
<thead>
<tr>
<th>To Access the Portal Sections Library</th>
</tr>
</thead>
</table>
| **Step 1** The top part of the Portal Builder lists existing portals. Click **Add** to create a portal or select the radio button for a portal and click **Edit** to change an existing portal. Creating and editing portals is described under [Portals](#).  
  
  For purposes of illustration, the following discussion assumes that you have selected a portal to be edited.  
| **Step 2** Scroll to the bottom of the Portal Editor page to find the Portal Sections Library section. Click **Portal Sections Library**.  
  
  The system collapses the Portal Properties section to display the list of existing portal sections to which you have security access in the Portal Sections Library section. From here you can add a new portal section, modify an existing portal section, or delete an existing portal section. |

### Search for a Portal Section

The Portal Builder page has tools to help you find a portal section based on its name, type, and/or heading. You can filter on any combination of these fields.

<table>
<thead>
<tr>
<th>To Search for a Portal Section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong> Type the desired search text in the Name, Type, and/or Header filter field and press the Enter key. The filters use the <strong>Contains</strong> operator to display the portal sections that meet the criteria entered.</td>
</tr>
</tbody>
</table>

### Add a Portal Section

Follow these steps to add a portal section.

<table>
<thead>
<tr>
<th>To Add a Portal Section</th>
</tr>
</thead>
</table>
| **Step 1** Click the **New** action immediately below the Portal Sections Library section bar.  
  
  The system displays the Portal Section form. |
To Add a Portal Section

Step 2 Enter the following fields:

- **Name:** This is the name used to identify the portal section in the Portal Sections Library. This name must be unique.
- **Header:** This text displays in the portal section’s section bar. It can be the same as or different from the Name.
- **Type:** Use the drop-down list to identify the type of portal section you are adding. Select from the following values:
  - **Report** Contains the result of any type of IBM TRIRIGA report.
  - **External** Shows the contents of an arbitrary URL.
  - **Scorecard** Displays a scorecard.
  - **Quick Links** Shows a Quick Links navigation collection.
  - **Form – Record Add** Displays the form for creating a record.
  - **Form – Record View** Displays an existing record through its form.

Step 3 Click **Apply**.

Step 4 Continue adding fields to describe the new portal section.

- **Tooltip:** The text displayed when the user hovers over the section title or color.
- **Description:** Enter descriptive information about the portal section.
- **Related Links:** Reference a navigation collection from the Navigation Builder.
- **Header Color:** The color of the text in the section’s header. If you do not choose a color (this is the default), the color will be the default color defined in the Style Manager. To set a color, click the 🌈 icon. The system displays a palette of colors.

To use the Basic tab, click the desired color.

The Advanced tab offers a Photoshop-like method of choosing the color. You have four ways to specify the color: By selecting the area to the left and the color spectrum in the middle; by entering the $r$, $g$, and $b$ values directly; by entering the $h$, $s$, and $v$ values directly; or by entering the $hex$ value directly (do not forget to put the # in front of the hex value). If you are entering the values directly, you will need to click inside the color picker or press tab for the color to update. When you are satisfied, click **Apply**.

With either method, once you have selected a color, the color palette disappears and a sample of the selected color appears to the left of the 🌈 icon.

- **Header Font:** Select the font for the header text.
- **Header Weight:** Determines the style of the text in the header. Select from Bold,
To Add a Portal Section

- **Italic**, or **Regular**.
  - **Header Size**: Select the font size for the header text.
  - **Header Type**: Select from **None**, **Title**, or **Regular**.

- **None**
  - No header will appear at the top of the section.

- **Title**
  - There will be a header that has a background color that makes the header look like a title bar. This is the usual setting for this field.

- **Regular**
  - The header will appear with the same background color as the rest of the section.

- **Border Color**: The color of the portal section’s border. If no color is chosen (this is the default), the section’s border color will be the default color defined in the Style Manager. To set a color, see the description above.

- **Background Image**: If an image is chosen in this field, it is used as the background image for the section. The background of the section will be tiled with this image. Because the background is covered with the specified image, the background color is not visible when a background image is selected.
  
  Click the Search icon 🕵️ to select an image for the background. This causes a dialog window to pop up in which you specify the name of a file containing an image. Click the Clear icon to select no background image (this is the default).

- **Scope**: This field is not used and should be set to **Company**.

- **Auto Refresh**: When selected, the contents of the portal section will be refreshed periodically with current data. How often this happens is determined by the value in the **Refresh Time** field.

- **Refresh Time**: This field only appears when the Auto Refresh check box is checked. It contains the number of seconds that should pass between times that the system refreshes the content of the portal section.

The remaining fields depend on the value of **Type**.
To Add a Portal Section

**Step 5** When Type is **Report**, the Portal Section contains the following additional properties:

- **Query**: Click the Search icon 📊 to select the IBM TRIRIGA report. The system displays all results of the query.

- **Show Query Actions**: When checked, the portal section header contains the report’s actions. This is checked by default.

- **Hide Metric Filters**: When checked and a metric query is selected, the portal section does not display metric query filters. The filters show if the user maximizes the portal section. This is not checked by default.

- **Max Records Displayed**: Specifies the maximum number of records to be rendered in the portal section. **10** is the default value. If the value is set to **100** or more, at runtime the report section will render a view that will allow the user to do functions that can be done in a full report view, such as filter and export.

- **Show Query Header**: When checked, the report header displays at the top of the section. For most reports, this should be checked. This is not checked by default.

**Step 6** When Type is **External**, the Portal Section contains the following additional property:

- **Url**: Enter the URL that will be opened and displayed in the portal section.

  *Note* - Only external http URLs, internal URLs and referencing .htm and .html files can be used in the portal section

- **Auto Resize**: When selected, the height of the portal section is adjusted to fit the content.

**Step 7** When Type is **Scorecard**, the Portal Section contains the following additional property:

- **Scorecard**: Either enter the name of the scorecard or click the Search icon 📊 and select from the choices.

**Step 8** When Type is **Quick Links**, the Portal Section contains the following additional properties:

- **Large View-Includes Icons**: When selected, the portal section renders with icons for the link items. This is not selected by default.

- **Small View-Does not Include Icons**: When selected, the portal section renders without the icons for the link items. This is selected by default.

- **Quick Links Collection**: Select the navigation collection to be displayed in this field. The drop-down list only displays navigation collections of type Quick Links.
To Add a Portal Section

**Step 9** When Type is Form – Record Add, the Portal Section contains the following additional properties:

- **Module**: Select the module to be used to create the added record.
- **Form**: Select the form to be used to create the added record.
- **Pre-Create Workflow**: The workflow selected here will be executed before the system creates the record.

**Step 10** When Type is Form – Record View, the Portal Section contains the following additional property:

- **Query**: Click the Search icon to select the IBM TRIRIGA report. The system displays the first result returned by the query selected through the record form.

**Step 11** Click OK when the information about the new portal section is complete.

Modify a Portal Section

Follow these steps to modify a portal section.

**To Modify a Portal Section**

**Step 1** Select the radio button for the portal section and click the Edit action immediately below the Portal Sections Library section bar.

**Step 1** Update the portal section fields and click OK.

Delete a Portal Section

Follow these steps to delete a portal section.

**To Delete a Portal Section**

**Step 1** Select the radio button for the portal section and click the Delete action immediately below the Portal Sections Library section bar.

**Note** - When you click Delete, the system checks to see whether the portal section is used in any portal. If it is, you will be asked to remove the portal section from the portals before deleting.

**Note** - If the portal section is a System portal section, the system displays an advisory message and does not delete the portal section.
Portals

Use the Portal Builder tool to describe the layout of portal sections in a portal. IBM TRIRIGA ships more than 100 standard portals. These standard portals are set up for many of the roles present in your organization. Use the Portal Builder to create additional portals or to modify existing ones to suit the needs of your company.

Tip - If you are planning to add a new portal or change an existing one, first make sure that the components you need are ready in the Portal Sections Library.

Use the Portal Builder to create portals, as described below. The top part of the Portal Builder page lists existing portals. The Portal Sections Library contains portal sections available to be put into a portal. From here you can add a new portal, modify an existing portal, copy an existing portal, or delete an existing portal.

Add a Portal

Follow the steps to add a portal.

To Add a Portal

Step 1

To create a portal, click **Add**.

The system displays the Portal Builder page. You will use the Portal Properties section on the left side to define the portal. As you use the Portal Sections Library (also on the left side) to add portal sections to the portal, the system displays a mockup of each portal section in the Portal Layout tab on the right side. As you use the Portal Sections Library to define portal sections that a user can add to their portal with the personalization process, the system displays the list of selected portal sections in the Related Portal Sections tab on the right side.

Step 2

In the Portal Properties section, specify the following fields:

- **Name**: This is the name used to identify the portal in the Portal Builder. This name must be unique.
- **Label**: This text displays in the portal menu bar.
- **Description**: Describe the purpose of the portal.
- **Layout**: Defines the overall structure of the portal. The values in the drop-down list follow:
  - **One**: The portal will be one panel wide and look like the mockup to the right.
  - **Two Equal**: The portal will have two vertical panels of equal size and look like the mockup to the right.
To Add a Portal

<table>
<thead>
<tr>
<th>Two 30/70</th>
<th>The portal will have two vertical panels and look like the mockup to the right. The left panel will consume 30% of the portal. The right panel will consume 70% of the portal. This is the default.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Three Equal</td>
<td>The portal will have three vertical panels of equal size and look like the mockup to the right.</td>
</tr>
<tr>
<td>Three 20/60/20</td>
<td>The portal will have three vertical panels and look like the mockup to the right. The left panel will consume 20% of the portal. The middle panel will consume 60% of the portal. The right panel will consume 20% of the portal.</td>
</tr>
</tbody>
</table>

**Step 3** Click **Save**.

**Step 4** Click **OK**.

**Step 5** Scroll to the bottom of the Portal Builder page. Click **Portal Sections Library**. The system collapses the Portal Properties section to display the list of existing portal sections in the Portal Sections Library section.

**Step 6** Select the check box of the portal section you wish to add to the portal and click **Add to Portal**.

The system displays the portal section in the Portal Layout tab on the right side.

**Step 7** If you want the portal section to be collapsed by default in a portal, select the **Collapsed By Default** check box in the portal section in the Portal Layout tab.

**Step 8** Continue adding portal sections. Click **Save**.

**Step 9** You can rearrange portal sections in the Portal Layout tab by selecting the section bar of a section and dragging the section to a different location. For example, you could start with this:

- Upper Left: Moves by Building
- Lower Left: Application Builder
- Upper Right: Moves By Day For The Next Week
- Lower Right: Application Administration
To Add a Portal

and rearrange to meet your design goal, perhaps like this:

- Upper Left: Application Builder
- Lower Left: Application Administration
- Upper Right: Moves By Day For The Next Week
- Lower Right: Moves by Building

**Step 10** To remove a portal section from the Portal Layout tab, click the Clear icon in the section bar of the portal section. This does not remove the portal section from the Portal Sections Library.

**Step 11** You can adjust the layout of the portal by clicking the Portal Properties section bar and selecting a different value for layout.

**Step 12** To include portal sections that a user might wish to add to the portal during personalization, select the Related Portal Sections tab.


**Step 13** Scroll to the bottom of the Portal Editor page. Click Portal Sections Library.

**Step 14** The system displays a list of available portal sections. Select the check box of the portal section you wish to add to the Related Portal Sections and click Add to Related Portal Sections List.

**Step 15** The system adds the portal section to the list in the Related Portal Sections tab.

**Step 16** Continue adding portal sections to the Related Portal Sections tab.

**Step 17** To remove a portal section from the Related Portal Sections list, select its check box and click Delete.

**Step 18** When your new portal is complete, click Save & Close.

**Step 19** Click OK. This returns you to the Portal Builder page.

**Modify a Portal**

Follow the steps to modify a portal.
To Modify a Portal

**Step 1** Select the check box for the portal and click **Edit**.

**Step 2** The system displays the Portal Builder page. Change the Portal Properties, Portal Layout tab, and/or Related Portal Sections tab. When you have finished, click **Save** or **Save & Close**.

*Attention* - If you do not click **Save** or **Save & Close**, you will lose your changes.

**Step 3** Click **OK**.

Copy a Portal

Follow the steps to copy a portal.

**To Copy a Portal**

**Step 1** Select the check box of the source portal and click **Copy**.

**Step 2** The system displays the Copy Portal form. Enter the **New Portal Name** and click **Save**.

**Step 3** The new portal now shows in the portals page.

Delete a Portal

Follow the steps to delete a portal.

**To Delete a Portal**

**Step 1** Select the portal’s check box and click **Delete**.

**Step 2** Click **OK** in the delete confirmation window.

Navigation Builder

The Navigation Builder tool manages portal navigation. Several key concepts follow:

- **A Navigation Collection** is a hierarchical structure that contains navigation items. It displays one or many navigation items in a hierarchical structure. A navigation collection can be used as a menu, a quick links portal section, or related links. It can be associated with multiple users and can be invoked from more than one place.

- **A Navigation Item** is an element of a navigation collection. A navigation item can be referenced from multiple navigation collections.
A Navigation Target is IBM TRIRIGA content or external content that can be navigated to. Examples of navigation targets are forms, query master/detail displays, scorecards, the Data Modeler, and an external URL.

Create and edit menu and navigation items in the Navigation Builder.

Access the Navigation Builder

Follow the steps to access the Navigation Builder tool.

To Access the Navigation Builder

Step 1 Select Navigation Builder from the Tools > Builder Tools menu or from the Tools - Application Builder portal section.

The system displays the Navigation Builder page. The items on the page are navigation collections, which span through more than one page that the user has to browse through. Those pages show each navigation collection name, label, description, and type. From here you can add a navigation collection, modify an existing navigation collection, copy an existing navigation collection, or delete an existing navigation collection.

The actions on the top of the Navigation Builder page are as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Add a navigation collection.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edit the selected navigation collection.</td>
</tr>
<tr>
<td>Copy</td>
<td>Create a navigation collection containing the same navigation items as the selected navigation collection.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected navigation collection.</td>
</tr>
</tbody>
</table>

Search for a Navigation Collection

The Navigation Builder page has tools to help you find a navigation collection based on its name, label, description, and/or type. You can filter on any combination of these fields.

To Search for a Navigation Collection

Step 1 Enter the desired search text in the Name, Label, Description or Type filter fields. The filters use the Contains operator to display the navigation collections that meet the criteria entered.
Navigation Collections

A navigation collection is a hierarchical structure that contains navigation items; it displays navigation items in a hierarchical structure. A navigation collection can be used as a menu, a quick links portal section, or related links portal section. It can be associated with multiple users and can be invoked from more than one place.

Add a Navigation Collection

Follow the steps to create a navigation collection.

To Add a Navigation Collection

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Click Add.  
The system displays the New Navigation Collection page. You will use the Navigation Collection Properties section on the left side to define the navigation collection. |
| Step 2 | In the Navigation Collection Properties section, specify the following fields:  
- **Name**: The system name for the navigation collection. This must be unique.  
- **Label**: The display label for the navigation collection. |
| Step 3 | Continue specifying the following fields:  
- **Description**: An explanation of the navigation collection.  
- **Help Text**: Provides instructional text. |
| Step 4 | Select a value from the **Type** drop-down box. Select from the following values:  
- **Menu**: The navigation collection is intended for use as a primary menu.  
- **Quick Links**: The navigation collection contains links intended for use in a Quick Links portal section. Refer to the discussion of portal sections elsewhere in this user guide.  
- **Related Links**: The navigation collection contains links intended for use in any portal section type. The Related Links property in the portal section form associates a related links navigation collection to a portal section. |
To Add a Navigation Collection

Step 5  A new navigation collection requires at least one navigation item before the system will save it. To display existing navigation items, scroll to the bottom of the navigation collection configuration page and click **Navigation Items Library**.

Attention - The system discards your work if you click **Save & Close** before you add at least one navigation item to a new navigation collection.

The system collapses the Navigation Collection Properties section to display the list of existing navigation items in the Navigation Items Library section. In addition to selecting a navigation item for this navigation collection, from here you can add a new navigation item, modify an existing navigation item, copy an existing navigation item, or delete an existing navigation item.

Step 6  Click the navigation item to select it. Click **Add to collection**.

The system adds the selected navigation item to the Navigation Items tab on the right side of the page.

Step 7  Click **Save** to create the navigation collection.

Step 8  Click **OK** in the confirmation message.

The system makes the following validations to ensure that the number of levels of navigation is within the maximum for its type:

- If Type is **Menu**, the navigation collection cannot have more than four levels of navigation.
- If Type is **Quick Links**, the navigation collection cannot have more than two levels of navigation.
- If Type is **Related Links**, the navigation collection cannot have more than one level of navigation.

The actions on the top of the navigation collection page are as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Saves current changes to the navigation collection. You can continue editing the navigation collection properties.</td>
</tr>
<tr>
<td>Save &amp; Close</td>
<td>Saves current changes to the navigation collection, closes the navigation collection properties editor, and displays the list of navigation collections.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Group Overrides</td>
<td>Presents the Group Overrides Editor where you can specify Group-specific overrides. More details on the Group specific overrides are provided under Group Overrides.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Displays a confirmation window asking you to verify the action prior to abandoning changes made since the last save. When you confirm, the system displays the list of navigation collections.</td>
</tr>
</tbody>
</table>

**Modify a Navigation Collection**

Follow these steps to modify a navigation collection.

1. **Step 1** Select the navigation collection. The navigation collection highlights when clicked. Click **Edit**.
   
The system displays the navigation collection configuration page.
2. **Step 2** Update the navigation collection.
3. **Step 3** Click **Save** or **Save & Close**.
4. **Step 4** Click **OK** in the confirmation message.

The system makes the following validations to ensure that the number of levels of navigation is within the maximum for its type:

- If Type is **Menu**, the navigation collection cannot have more than four levels of navigation.
- If Type is **Quick Links**, the navigation collection cannot have more than two levels of navigation.
- If Type is **Related Links**, the navigation collection cannot have more than one level of navigation.

**Copy a Navigation Collection**

Follow these steps to copy a navigation collection.

1. **Step 1** Select the navigation collection. The navigation collection highlights when clicked. Click **Copy**.

© Copyright IBM Corporation 2011, 2014.
To Copy a Navigation Collection

Step 2 Enter the navigation name in the Copy form.

Step 3 Click Save.

The system creates the copy and lists it as the first item in the navigation collection list. The system sorts the list the next time.

Delete a Navigation Collection

Follow these steps to delete a navigation collection.

To Delete a Navigation Collection

Step 1 Select the navigation collection. The navigation collection highlights when clicked. Click Delete.

Step 2 Click OK in the delete confirmation window.

Group Overrides

The purpose of Group Overrides is to provide a mechanism for excluding a navigation item from a navigation collection or for changing a navigation item to have a group-specific target.

Access Group Overrides

Follow the steps to access group overrides for a navigation collection.

To Access Group Overrides for a Navigation Collection

Step 1 In the Navigation Builder, select and edit the navigation collection. Click Group Overrides.

The system displays the Group Overrides tab.

Hide a Navigation Item from a Group

Follow the steps to hide a navigation item in a navigation collection from a group.

To Hide a Navigation Item from a Group

Step 1 Select the security group to be prevented from seeing the navigation item from the Security Group drop-down list.
To Hide a Navigation Item from a Group

**Step 2** Select the **Hide From Group** check box for each navigation item to be hidden from the selected group. If an item is hidden from a group, its target type no longer applies and the system does not allow it to be changed.

**Step 3** Click **Save** or **Save & Close**.

**Step 4** Click **OK** in the confirmation message.

Change a Navigation Item to Have a Group-Specific Target

Follow the steps to change a navigation item in a navigation collection so that its target is different for a specific security group.

To Give a Navigation Item a Group-Specific Target

**Step 1** Select the security group to receive a group-specific target from the **Security Group** drop-down list.

**Step 2** Select the navigation item in the hierarchy tree where you want to set a new navigation target for the security group selected. The navigation item highlights when clicked.

**Step 3** Click **Edit** in the Group Overrides tab.

The system displays the Group Overrides Editor.

**Step 4** Set the new target type in the Group Target Details section.

Select the **Hide From Group** check box as appropriate. For a description of this field, see the **Hide a Navigation Item from a Group** discussion in this guide.

**Step 5** Click **Save & Close** in the Group Overrides Editor.

**Step 6** Click **OK** in the confirmation message.

Navigation Items

Navigation items are the building blocks from which navigation collections are constructed. A navigation item can be referenced from many navigation collections. Navigation items can be created, edited, copied, and deleted from the Navigation Items Library within the Navigation Builder.

Access the Navigation Items Library

Follow the steps to access the Navigation Items Library.
To Access the Navigation Items Library

Step 1  The Navigation Builder lists existing navigation collections. Click Add to create a navigation collection or select a navigation collection and click Edit to change an existing navigation collection. Creating and editing navigation collections is described under Navigation Collections.

For purposes of illustration, the following discussion assumes that you have selected a navigation collection to be edited.

Step 2  Scroll to the bottom of the page to find the Navigation Items Library section. Click Navigation Items Library.

The system collapses the Navigation Collection Properties section to display the list of existing navigation items to which you have security access in the Navigation Items Library section. The display is sorted by target type. From here you can add a new navigation item or modify, copy, or delete an existing navigation item.

Search for a Navigation Item

The Navigation Builder page has tools to help you find a navigation item.

To Search for a Navigation Item

Step 1  Enter the desired search text in the Name, Label, or Target Name filter fields. The filters use the Contains operator to display the navigation items that meet the criteria entered.

Step 2  The search filter for Target Type is a drop-down list with the navigation item types listed as options. Select from the following values: Builder, Call Center, Document Management, External Url, Master/Detail Default Query, Master/Detail Hierarchy, Master/Detail Query, My Calendar, My Profile, My Timesheet, Portal, Record Add, Record Open, Report, and Scorecard.

Step 3  Select a Target Type from the list. The system displays the navigation items of that type.

Add a Navigation Item

Follow these steps to create a navigation item in the Navigation Items Library.

To Add a Navigation Item

Step 1  Click Add (immediately below the Navigation Items Library section bar).

The system displays the Navigation Item Editor.
To Add a Navigation Item

Step 2 Enter the following fields in the Item Details section:

- **Name**: The system name for the navigation item. This must be unique.
- **Label**: This text displays to the user if not a dynamic label. If a dynamic label, this text displays to the user until the dynamic label values are fetched and displayed. Navigation item labels are trimmed when saved to facilitate label translation.

Step 3 Click **Save**.

Step 4 Click **OK**.

Step 5 Continue adding fields in the Item Details section.

- **Help Text**: Instructional text displayed to the user.
- **Visible in Sitemap only**: Select this check box if this navigation item should not be visible in the menu. The navigation item will remain visible in the user’s sitemap and when incorporated to a portal section, though. If this navigation item has a dynamic label, only the static portion of the label displays in the sitemap.
- **Dynamic Label**: Select this check box if the label for the navigation item is to be dynamic. A dynamic label contains three parts: an optional prefix, the result of a query, and an optional suffix.

When you check the **Dynamic Label** check box, the system adds the Default Query Label section to the Navigation Item Editor display. Use this section to specify the elements comprising the dynamic label.

Step 6 First, identify the query:

- **Module**: Select the module from the drop-down list. The list contains modules to which you have security access.
- **Business Object**: Select the business object from the drop-down list. The list contains business objects in the selected module to which you have security access.
- **Report**: Select the report to be run to obtain the dynamic result value to be displayed in the dynamic label. If the report selected is a metric query, the result is the count and the display is the metric threshold icon. For all other reports, the expected result is a number and the display is that number.

Step 7 If you selected the **Dynamic Label** check box, specify the text to appear before or after the dynamic label query results.

- **Prefix**: Text that displays before the dynamic label query results. Optional.
- **Suffix**: Text that displays after the dynamic label query results. Optional.
To Add a Navigation Item

Step 8 An icon specified in the Icon Details section displays in front of the navigation item's label.

- **Icon Selector**: Browse to identify the file to be used as the navigation item's icon. The icon should be stored in the \userfiles\images directory of the IBM TRIRIGA install.

Step 9 Select **Upload Icon**.

The system uploads the icon file and displays a *Preview* of the image and the system name of the file in *Icon*.

Select **Clear Icon** to clear the information in the Icon Details section.

Step 10 The Target Details section specifies the default or group target. Start by selecting the **Target Type** from the drop-down list. Select from the following values: **Builder**, **Call Center**, **Document Management**, **External Url**, **Master/Detail Default Query**, **Master/Detail Hierarchy**, **Master/Detail Query**, **My Calendar**, **My Profile**, **My Timesheet**, **Portal**, **Record Add**, **Record Open**, **Report**, and **Scorecard**.

When you select a value for Target Type, the system expands the Target Details section to include properties appropriate for the Target Type selected. The expanded Target Details section includes **Target Title**, which is displayed to the user.

Step 11 When **Target Type** is **Builder**, the Target Details section contains the following additional property:

- **Builder**: Select a builder from the drop-down list. Choose from the following values: **Association Manager**, **Currency Conversion**, **Data Integrator**, **Data Modeler**, **Label Manager**, **License Manager**, **List Manager**, **Navigation Builder**, **Object Migration**, **Portal Builder**, **Report (Query) Manager**, **Scorecard Builder**, **Style Manager**, **State Family Manager**, and **Workflow Builder**.

Step 12 When **Target Type** is **Call Center**, the Target Details section also displays the Target Title field.

Step 13 When **Target Type** is **Document Management**, the Target Details section also displays the Target Title field.

Step 14 When **Target Type** is **External Url**, the Target Details section also displays the Target Title field and contains the following additional property:

- **External Url**: Enter the complete URL, including http:// or https://.
To Add a Navigation Item

Step 15 When Target Type is Master/Detail Default Query, the Target Details section contains the following additional sections and properties.

- In the Form section, identify the Module and Form.
- In the Form Properties section, select the Show Related Reports check box to allow the user to view the reports related to the select form.
- In the Default Query Columns section, select the columns to display for the form by clicking the check boxes for Name, Updated Date, Created Date, Control Number, and Image.
- In the Actions section, the system displays the actions for the selected form. You can add, edit, delete, move up, or move down an action.

Step 16 When Target Type is Master/Detail Hierarchy, the Target Details section contains the following additional sections and properties.

- In the Target Details section, select the Modify Hierarchy check box if the user is allowed to change the hierarchy from this navigation item and select the Hierarchy from the drop-down list.
- In the Query section, identify the optional query associated with this hierarchy. Select Module, Business Object, and Report from the drop-down lists.
- In the Special Views section, the system displays the Special Views defined for the selected hierarchy. You can add, edit, or delete from the list.

Step 17 When Target Type is Master/Detail Query, the query results display in a master/detail format. The Target Details section contains the following additional sections and properties.

- In the Target Name section, identify the query. Select Module, Business Object, and Report from the drop-down lists.
- In the Form section, specify an optional form to use for the query display. Select the Module and Form from the drop-down lists.

Step 18 When Target Type is My Calendar, the Target Details section also displays the Target Title field.

Step 19 When Target Type is My Profile, the Target Details section also displays the Target Title field.
To Add a Navigation Item

**Step 20** When Target Type is *My Timesheet*, the Target Details section also displays the Target Title field.

**Step 21** When Target Type is *Portal*, the Target Details section also displays the Target Title field and contains the following additional property:

- *Portal*: Select the portal from the drop-down list.

**Step 22** When Target Type is *Record Add*, the Target Details section contains the following additional sections and properties.

- In the Target Name section, identify the *Module* and *Form* to be used to add the record. Select from the drop-down lists.

- In the Pre-Create Workflow section, identify the optional workflow to run before the form displays. Select *Module*, *Business Object*, and *Report* from the drop-down lists.

**Step 23** When Target Type is *Record Open*, the Target Details section contains the following additional section and properties.

- In the Target Name section, identify the *Module*, *Business Object*, and *Report* to be used to view the record. Select from the drop-down lists. The first result returned by the report displays in the target viewing area.

**Step 24** When Target Type is *Report*, the Target Details section contains the following additional section and properties.

- In the Target Name section, identify the *Module*, *Business Object*, and *Report* to be displayed. Select from the drop-down lists.

**Step 25** When Target Type is *Scorecard*, the Target Details section contains the following additional properties:

- *Scorecard*: Identify the scorecard from the drop-down list.

- *Default Report*: The report used as the query in the three panels of the scorecard.

**Step 26** The Where Used section lists the navigation collections that currently reference this navigation item.

**Step 27** Click *Save & Close* when the information about the new navigation item is complete.

**Modify a Navigation Item**

Follow these steps to change an existing navigation item in the Navigation Items Library.
To Modify a Navigation Item

Step 1  Select the navigation item. The navigation item highlights when clicked. Click **Edit**.

Step 2  The system displays the Navigation Item Editor.

Step 3  Update the navigation item fields and click **Save & Close**.

Step 4  Click **OK** in the confirmation message.

Copy a Navigation Item

Follow these steps to copy a navigation item in the Navigation Items Library. If you copy a navigation item that has child items, the child items are not copied to the new navigation item. A navigation collection is the only entity that maintains navigation structure.

To Copy a Navigation Item

Step 1  Select the navigation item. The navigation item highlights when clicked. Click **Copy**.

Step 2  Enter the **New Navigation Item Name** in the Copy Navigation Item form.

Step 3  Click **Save**.

The system creates the copy and lists it in the navigation item list.

Delete a Navigation Item

Follow these steps to delete a navigation item from the Navigation Items Library.

To Delete a Navigation Item

Step 1  Select the navigation item. The navigation item highlights when clicked. Click **Delete**.

Step 2  Click **OK** in the confirmation message.

**Note** - Deleting a navigation item from the Navigation Items Library deletes it from all navigation collections. However, if you try to delete a navigation item that has child items in a navigation collection, the system displays an advisory message and does not delete the navigation item.

Add a Navigation Item to a Navigation Collection

Follow these steps to add a navigation item to a navigation collection.
To Add a Navigation Item to a Navigation Collection

Step 1  Select the navigation item. The navigation item highlights when clicked. Click Add to collection.

The system adds the navigation collection to the bottom of the Navigation Items tab.

Step 2  Click Save or Save & Close when the Navigation Items tab is complete.

The system makes the following validations to ensure that the number of levels of navigation is within the maximum for its type:

- If Type is Menu, the navigation collection cannot have more than four levels of navigation.
- If Type is Quick Links, the navigation collection cannot have more than two levels of navigation.
- If Type is Related Links, the navigation collection cannot have more than one level of navigation.

Change the Arrangement of Navigation Items in a Navigation Collection

Follow these steps to change the arrangement of navigation items in a navigation collection.

To Change the Arrangement of Navigation Items in a Navigation Collection

Step 1  To change the position of the navigation item in the navigation items list, select the navigation item and drag it to the desired position. Use this method to build lists of navigation items and/or hierarchies of navigation items.

Step 2  Click Save or Save & Close when the Navigation Items tab is complete.

The system makes the following validations to ensure that the number of levels of navigation is within the maximum for its type:

- If Type is Menu, the navigation collection cannot have more than four levels of navigation.
- If Type is Quick Links, the navigation collection cannot have more than two levels of navigation.
- If Type is Related Links, the navigation collection cannot have more than one level of navigation.

Remove a Navigation Item from a Navigation Collection

Follow these steps to delete a navigation item in a navigation collection.
To Remove a Navigation Item from a Navigation Collection

**Step 1**  Click the navigation item you want to remove from the navigation collection. Click **Remove**. This only removes the navigation item from the navigation collection. The navigation item remains in the Navigation Items Library.

**Step 2**  Click **Save** or **Save & Close** when the Navigation Items tab is complete.

The system makes the following validations to ensure that the number of levels of navigation is within the maximum for its type:

- If **Type is Menu**, the navigation collection cannot have more than four levels of navigation.
- If **Type is Quick Links**, the navigation collection cannot have more than two levels of navigation.
- If **Type is Related Links**, the navigation collection cannot have more than one level of navigation.

Create a Navigation Item from the Navigation Items Tab

Follow these steps to create a navigation item while working in a navigation collection’s Navigation Items tab.

**To Create a Navigation Item while in the Navigation Items Tab**

**Step 1**  Click **Edit** in the Navigation Items tab.

The system displays the Navigation Item Editor, which is described under Add a Navigation Item.

**Step 2**  Click **Save** or **Save & Close** when the Navigation Items tab is complete.

The system makes the following validations to ensure that the number of levels of navigation is within the maximum for its type:

- If **Type is Menu**, the navigation collection cannot have more than four levels of navigation.
- If **Type is Quick Links**, the navigation collection cannot have more than two levels of navigation.
- If **Type is Related Links**, the navigation collection cannot have more than one level of navigation.
Example

Create a Course Management Portal Section to Access a Course Form

To Create the Course Management Portal Section

Step 1  From Tools > Builder Tools, open the Navigation Builder.

Step 2  To add a new navigation collection, click Add.

Step 3  The new navigation collection page opens.

- Enter the Name: cstCourseManagement – Quick Links – Course Management
- Enter the Label: Course Management
- Select the Type: Quick Links
- When you are finished, click Save.

Step 4  Next, click Navigation Items Library at the bottom left of the page.

Step 5  Click Add to create a navigation item.

Step 6  Next:

- Enter the Name: cstMaster Detail – Courses
- Enter the Label: Courses

Step 7  Then:

- Select Target Type: Master/Detail Default Query
- Enter Target Title: Courses
- Select Module: cstCourseManagement
- Select Form: cstCourse
- Under Default Query Columns select: Name, Control Number, and Updated date

Step 8  Under Actions, click Add.

Step 9  In the window:

- Select Action Type: System Add
- Enter Action Name: Add
- Enter Action Label: Add
- Click Save to add the action to the navigation item.
- Repeat for System Delete.
To Create the Course Management Portal Section

**Step 10** Save & Close the navigation item at the top of the Navigation Item Editor.

**Step 11** In the Navigation Items Library:
- Filter the Library by Name: Courses
- Select the item we created by clicking it.
- Click Add to Collection.
- Click Save & Close located above the Navigation Collection Properties.

**Step 12** The Course Management navigation collection appears in the Navigation Builder list.
- From Tools > Builder Tools, open the Portal Builder to create the portal section.

**Step 13** Select the Portfolio Landing Page and click Edit.

**Step 14** Click Portal Sections Library in the bottom left hand corner.

**Step 15** Click New to create a portal section.

**Step 16** In the Portal Section form:
- Enter the **Name**: Course Management – Portfolio Landing Page
- Enter the **Header**: Course Management

**Step 17** Further down the form:
- Select **Type**: Quick Links
- For Quick Links Collection, pick the `cstPortfolio - Quick Links - Course Management` collection we created earlier.

**Step 18** Click OK to save and close the portal section.

**Step 19** Select the newly created portal section and click Add To Portal to add it to the Portfolio page.

**Step 20** Click Save & Close to apply all of your changes.

**Note** - You may need to sign out and sign back in for the changes to take effect.

**Step 21** Click the Portfolio menu item to go the Portfolio page.

**Step 22** Click Courses to go to the results page.
To Create the Course Management Portal Section

Step 23 Finally:

- Click Add to create a Course record.
- Enter the details of the record and click Create Draft to save the new record.
3. Brand with Colors and Logos

This chapter describes how to brand the IBM TRIRIGA portal and applications with your logos and colors. The Style Manager tool tailors the portal’s appearance so it is unique and specific to your organization’s standards. Using the Style Manager, you can change the visual components for portals, managers, wizards, IBM TRIRIGA Objects, Form Styles, and Rich Text Editor Styles. First this chapter discusses how to use the Style Manager tool. Then it gives specific branding examples, including how to customize the portal banner.

Access the Style Manager

Follow the steps to access the Style Manager.

<table>
<thead>
<tr>
<th>To Access the Style Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
</tr>
<tr>
<td>To access the Style Manager tool, select <strong>Style Manager</strong> from the Tools &gt; Administration menu or from the Utilities portal section.</td>
</tr>
<tr>
<td>- The components that can be customized from the Style Manager are listed on the action bar: Portal, Manager, Wizard, IBM TRIRIGA Objects, Form Styles, and Rich Text Editor Styles.</td>
</tr>
<tr>
<td>- The list in the Visual Components section changes depending on the selection made on the action bar.</td>
</tr>
<tr>
<td>Step 2</td>
</tr>
<tr>
<td>To select a Visual Component, click the radio button to the left of the name.</td>
</tr>
<tr>
<td>- The display in the rest of the Style Manager changes depending on the selection made on the action bar and in the Visual Components section.</td>
</tr>
<tr>
<td>Step 3</td>
</tr>
<tr>
<td>Click a color in the color palette at the top to adjust the color for the selected component. You also can use the RGB color values or HEX value to the right of the color palette to define the color.</td>
</tr>
<tr>
<td>- To preview a color change, click <strong>Use Value</strong> and the color displays in the right panel.</td>
</tr>
<tr>
<td>- The current target for the color change displays next to the color palette.</td>
</tr>
<tr>
<td>Step 4</td>
</tr>
<tr>
<td>When you are finished adjusting the portal appearance, click <strong>Save</strong>.</td>
</tr>
<tr>
<td>Step 5</td>
</tr>
<tr>
<td>Should you wish to return to the system default portal appearance, click <strong>Import</strong> (as described under <strong>Restore Default Settings</strong>).</td>
</tr>
</tbody>
</table>
Tailor Application Components

To customize the colors of the application components, access the Style Manager as described under Access the Style Manager.

To Tailor Application Components

**Step 1** Click the name of the component you wish to customize on the action bar:
- Portal
- Manager
- Wizard
- IBM TRIRIGA Objects
- Form Styles
- Rich Text Editor Styles

**Step 2** In the Visual Components section, click the radio button to the left of the visual component you wish to change.

*Note* - If a radio button is gray, the style cannot be changed for that component.

**Step 3** Make your changes.

The changes show in the preview panel of the page.

*Tip* - One way to view the change from IBM TRIRIGA Objects is to toggle between View Color Banner and View GIF Banner.

**Step 4** You can return to the default portal styles at any time by clicking Import (as described under Restore Default Settings).

**Step 5** When you have completed your changes, click Save.

*Note* - To view the changes made, first sign out of the application. The changes will show the next time you sign in.
Style Sheets

For some applications, you may want certain fields, sections, or tabs to be presented differently from others. You may want some fields to present data with a different font or other fields to have a label that is a different color. You may want some sections to have a different colored title bar. If you do want to do such things, you will want to do them not just in one form, but consistently throughout your application.

The IBM TRIRIGA Application Platform provides a way to do this in the form of style sheets. Fields have a property named Label Style Class that can determine the appearance of the field label. Fields also have a property named Data Style Class that can determine the appearance of the field data. Sections and tabs have a property named Style Class that determines their appearance.

To view, edit, delete, or create style sheets, use a tool named the Style Sheet Editor.

Note - Section Style must only be used to style section elements such as background color, border color, and width. Labels contained inside the section must be styled using the Label style class, where attributes related to fonts, such as font weight, size, and style, can be specified.

Access the Style Sheet Editor

Follow the steps to access the Style Sheet Editor.

To Access the Style Sheet Editor

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Select Style Sheet Editor.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>▪ The system displays the Style Sheet Editor form.</td>
</tr>
<tr>
<td></td>
<td>▪ The left side of the Style Sheet Editor contains a list of the defined style sheets. The Style Name column shows the names of the style sheets. The Type column shows the type of style sheet. The type of a style sheet determines whether the style sheet will apply to a tab, section, or field. The middle of the form shows the style properties. The right side of the form shows a sample.</td>
</tr>
</tbody>
</table>

| Step 2 | You can view the properties of a style sheet by selecting the radio button next to its name. |
The three actions in the section bar on the left side of the Style Sheet Editor are as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADD</td>
<td>To create a style sheet, click ADD and edit the new style sheet in the middle of the Style Sheet Editor. When done, click SAVE at the top of the Style Sheet Editor.</td>
</tr>
<tr>
<td>EDIT</td>
<td>To modify an existing style sheet, select the radio button next to the style sheet name and click EDIT. Edit the style sheet in the middle of the Style Sheet Editor. When done, click SAVE at the top of the Style Sheet Editor.</td>
</tr>
<tr>
<td>DELETE</td>
<td>To delete a style sheet, select the radio button next to the style sheet name and click DELETE.</td>
</tr>
</tbody>
</table>

Create/Modify a Style Sheet

Whether a style sheet is for a tab, section, or field, its properties are shown in the middle of the Style Sheet Editor. Not all of the properties apply to all kinds of style sheets.

Follow these steps to create or modify a style sheet:

To Create/Modify a Style Sheet

**Step 1** Enter/update the fields at the top:

- **Name**: The name of the style sheet. You are required to fill this in when you are creating a style sheet. This property is read-only when you are editing an existing style sheet.
- **Type**: The type of style sheet. This property is read-only when you are editing an existing style sheet. Select from the following values in the drop-down list:
  - Tab: Indicates that this style is to be applied to tabs.
  - Section: Indicates that this style is to be applied to sections.
  - Field: Indicates that this style is to be applied to field labels or field data.
To Create/Modify a Style Sheet

Step 2  Enter/update the fields in the Property section:

- **Background Color**: Sets the background color.

  There are several different ways to set the value of this property:

  - Enter the red, green, and blue values in the *Hex* field as one combined 24 bit hexadecimal value. Do not forget to put a `#` in front of the hex value.

  - Enter individual red, green, and blue values in the range 0-255 in the *R*, *G*, and *B* fields.

  - Click the `палитра` icon. The system displays a palette of colors.

    To use the Basic tab, click the desired color.

    The Advanced tab offers a Photoshop-like method of choosing the color. You have four ways to specify the color: By selecting the area to the left and the color spectrum in the middle; by entering the *r*, *g*, and *b* values directly; by entering the *h*, *s*, and *v* values directly; or by entering the *hex* value directly (do not forget to put the `#` in front of the hex value). If you are entering the values directly, you will need to click inside the color picker or press tab for the color to update. When you are satisfied, click **Apply**.

    With each method, once you have selected a color, the color palette disappears and a sample of the selected color appears to the left of the `палитра` icon.

Step 3  Enter/update the fields in the Box Properties section:

- **Border Width**: Determines the width of a border. Select from these values: Thick, Medium, Thin.

- **Border Style**: Determines the style of a border. The possible values for this property follow: none, dotted, dashed, solid, double, groove, ridge, insert, outset.

- **Border Color**: The color for the border. The ways to set the value of this property are discussed on **step 2**.

- **Border-Spacing**: Controls how much space is between grid cells. Select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

- **Border Collapse**: Determines if the borders in a tab or section are separated by some space or collapsed against each other. The possible values for this property are collapse (the default) or separate.

- **Margin-Bottom**: Controls the distance between the bottom of the content area and the bottom of the border. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

- **Margin-Left**: Controls the distance between the left side of the content area and the left side of the border. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.
To Create/Modify a Style Sheet

- **Margin-Right**: Controls the distance between the right side of the content area and the right side of the border. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

- **Margin-Top**: Controls the distance between the top of the content area and the top of the border. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

- **Padding-Bottom**: Controls the distance between the bottom of the border and the bottom of the grid cell. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

- **Padding-Left**: Controls the distance between the left side of the border and the left side of the grid cell. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

- **Padding-Right**: Controls the distance between the right side of the border and the right side of the grid cell. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

- **Padding-Top**: Controls the distance between the bottom of the border and the bottom of the grid cell. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

**Step 4** Enter/update the fields in the Font Properties section:

- **Font Style**: Determines the style of characters used. The possible values are: normal, italic, oblique.

- **Font Weight**: Determines the thickness of characters. The possible values for this property are: normal, bold, bolder, lighter, and numeric values.

- **Font Variant**: Specifies the use of a variant form of the font. The possible values are: normal, small-caps.

- **Font Size**: Determines the size of the font used. The possible values are numbers from 8 to 18.

- **Font Color**: Determines the color used to render the font. The ways to set the value of this property are discussed on step 2.

- **Font Family**: Determines the font. There are numerous values from which to choose.
To Create/Modify a Style Sheet

Step 5  Enter/update the fields in the Text Properties section:

- **Text-Align**: Controls the alignment of text. The possible values are: left, right, center, justify.
- **Text-Decoration**: Specifies if and how characters should be decorated with a solid line. The possible values are: none, underline, overline, line-through.
- **Text-Indent**: Determines the amount of indentation that should be applied to text. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.
- **Letter Spacing**: Determines how much extra space should be inserted between characters. Extra space between characters looks like this. You can select a specific value, for example, 7em, or you can select normal, in which case no extra space is inserted between characters.
- **Line Height**: Determines how much extra space should be inserted between lines of text. Extra space between lines of text looks like this.

You can select a specific value, for example, 7em, or you can select normal, in which case no extra space is inserted between lines of text.
To Create/Modify a Style Sheet

**Step 6**  Enter/update the fields in the General Properties section:

- **Width**: Specify a fixed width of a field or section. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

- **Height**: Specify a fixed numeric height of a field or section. You can select a specific value, for example, 7em, or you can select auto, in which case the value is determined automatically.

- **Visibility**: Determines if a tab, section, or field initially will be visible or hidden. The possible values follow:
  - `visible`: The tab, section, or field initially will be visible.
  - `hidden`: The tab, section, or field initially will be hidden.
  - `inherit`: If this is for a field, the field initially will be visible if the section that contains it is visible or hidden if the section that contains it is hidden. If this is for a section, the section initially will be visible if the tab that contains it is visible or hidden if the tab that contains it is hidden.

- **Position**: Determines if special positioning rules will be used for a field or section. The possible values follow:
  - `static`: Positioning is done normally.
  - `absolute`: A section will be positioned relative to the tab that contains it. A field will be positioned relative to the section that contains it.
  - `relative`: Positioning is relative to where the field or section would be if it were static.
  - `fixed`: Positioning is fixed.

**Step 7** When you are done, be sure to click **SAVE** at the top of the Style Sheet Editor.

Brand the Portal Banner

The Portal Banner can be tailored to match your company standards. There are two types of banners, the Color Banner with a center, right, or left logo, and the GIF Banner, with a left logo and links background image. The default banner is the GIF Banner. You can change the logo image, links background image, and colors.
GIF Banner

The GIF Banner has a left logo and links background image.

Begin customizing the GIF banner by selecting the color scheme and images you wish to use.

<table>
<thead>
<tr>
<th>Banner Image</th>
<th>Location</th>
<th>Required File Name</th>
<th>Standard Size in Pixels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Logo Image</td>
<td>Top left</td>
<td>logo.gif</td>
<td>Height = 40 Width = 236</td>
</tr>
<tr>
<td>Custom Links Background Image</td>
<td>Top right</td>
<td>linksBackground.gif</td>
<td>Height = 40 Width = 334</td>
</tr>
</tbody>
</table>

The height of the portal banner adjusts to the height of the custom logo image. The background image should be the same height as the custom logo image since background images typically do not scale. For example, if the custom logo image is changed to an image with a greater height, but the background image is not changed, the result might not be the intended customization.

For best results, all custom images should be the same height.

Step 1 Place the images in the `userfiles\images` directory of the IBM TRIRIGA installation folder. An example of this location in Windows is `C:\Tririga\userfiles\images`.

Step 2 In the Style Manager, select IBM TRIRIGA Objects.

Step 3 In the Visual Components section, select View GIF Banner.

Step 4 Specify whether the images go in the Left, Center, or Right.

Step 5 Click Save.

Clear the Cache

For these changes to take effect, both the browser cache and the application server cache must be cleared. You can clear the application server cache by restarting the application server or from the Administrator Console. The Administrator Console is described in more detail in the IBM TRIRIGA Application Platform 3 Administrator Console User Guide. The following steps show how to clear the application server cache from the Administrator Console:
To Clear Cache from the Administrator Console

**Step 1**  In the Managed Objects panel on the left side, select the radio button next to *Cache Manager*.

The system displays Cache Manager information in the right panel.

**Step 2**  In the Flush a Cache section, click *Portal Logo*.

**Step 3**  Select *Logout* in the left panel.

Color Banner

The Color Banner has a center, right, or left logo.

Begin customizing the color banner by selecting the color scheme and images you wish to use.

To Customize the Color Banner

**Step 1**  Name the image you want to use *logo.gif*. For best results, the image should be 149 x 18 pixels.

**Step 2**  Place *logo.gif* in the `userfiles\images` directory of the IBM TRIRIGA installation folder. An example of this location in Windows is `C:\Tririga\userfiles\images`.

**Step 3**  In the Style Manager, select *IBM TRIRIGA Objects*.

**Step 4**  In the Visual Components section, select *View Color Banner*.

**Step 5**  Specify whether the images go in the *Left*, *Center*, or *Right*.

**Step 6**  Click *Save*.

Clear the Cache

For these changes to take effect, both the browser cache and the application server cache must be cleared. You can clear the application server cache by restarting the application server or from the Administrator Console. The Administrator Console is described in more detail in the *IBM TRIRIGA Application Platform 3 Administrator Console User Guide*. The steps under Clear the Cache show how to clear the application server cache from the Administrator Console.
Restore Default Settings

IBM TRIRIGA ships with a set of standard colors and styles in a file named stylesheet.xml located in the userfiles\skin directory of the IBM TRIRIGA installation folder. An example of this location in Windows is C:\Tririga\userfiles\skin. You can export all current style configurations to an XML file with the Export action in the Style Manager. If you have custom colors, back them up.

The Import action uploads the stylesheet.xml file and applies the styles to the system. During the import, only the styles in the XML are applied; all other styles remain unchanged. To restore the styles to the IBM TRIRIGA default, import IBM TRIRIGA’s standard styles using the style XML supplied in stylesheet.xml.

Follow the steps to return to the system default colors.

To Return to System Default Colors

**Step 1**  Access the Style Manager as described in Access the Style Manager.

**Step 2**  Click Import.

- The colors revert to the definitions in the stylesheet.xml file, which must be located in the userfiles\skin directory of the IBM TRIRIGA installation folder. An example of this file location in Windows is C:\Tririga\userfiles\skin\stylesheet.xml.

- Build stylesheet.xml so that it contains IBM TRIRIGA’s blue.xml values, IBM TRIRIGA’s green.xml values, or your own values based on the XML structure in either blue.xml or green.xml. IBM TRIRIGA delivers blue.xml and green.xml with the IBM TRIRIGA installer.

To set a particular skin via the Style Manager:

- Build stylesheet.xml (the XML structure must match IBM TRIRIGA’s as-delivered blue.xml or green.xml).
- Click Import in the Style Manager.
- You may need to clear the browser cache.
- You may need to clear the Portal Logo cache in the Cache Manager of the IBM TRIRIGA Administrator Console (as described under Clear the Cache).
To Return to System Default Colors

Tip - A way to change to the green skin is to run a script. Scripts are located in the `<TRIRIGA Install>\userfiles\upgrades` directory. The scripts are as follows:

- `STYLE_SHEET_updates_trees_oracle.sql` (Oracle DB)
- `STYLE_SHEET_updates_trees_sqlserver.sql` (SQL Server)
- `T_TRITHRESHOLD_updates_trees_oracle.sql` (Oracle DB)
- `T_TRITHRESHOLD_updates_trees_sqlserver.sql` (SQL Server)

Step 3 Select a style .xml file to import. Click Import.

Step 4 After the import, the system displays a “The Import Was Successful” message. Click Close.

Step 5 Click Save.

Step 6 Click OK.

Note - To view the changes made, sign out of the application. The default portal colors will show the next time you sign in.

Change Report Logo

Follow these steps to change the logo that appears on standard reports:

To Change the Logo on Standard Reports

Step 1 In the Document Manager, check out the COMPANY_LOGO (logo.bmp) file.

Tip - Read how to use the Document Manager in the IBM TRIRIGA 10 Document Management User Guide.

Step 2 Update logo.bmp with your image. For best results, the image should be 219 x 57 pixels.

Step 3 In the Document Manager, check in the COMPANY_LOGO file.

Brand a Specific Portal Section

Each portal section can have a specific header color; header font, weight, size, and type; and background color and image. Specify these values in the Portal Builder, as described under Portal Sections in this user guide.
INDEX

Access Group Overrides, 20
Actions Section, 25
Add to collection, 18, 28
Add to Portal, 13
Add to Related Portal Sections List, 14
Administrator Console, 2, 41, 42
Background Color, 37
Blue Skin, 44
Border Collapse, 37
Border Color, 37
Border Style, 37
Border Width, 37
Border-Spacing, 37
Box Properties Section, 37
Builder, 24
Cache Manager, 42
Call Center, 24
Change a Navigation Item to Have a Group-Specific Target, 21
Collapsed By Default, 13
Color Banner, 40, 42
Color Palette, 33, 37
COMPANY LOGO, 44
Copy A Package, 16
Copy form, 20
Copy Navigation Item Form, 27
Copy Portal Form, 15
Data Style Class, 35
Default Query Columns Section, 25
Default Query Label Section, 23
Document Management, 24
Dynamic Label, 23
Export, 43
External, 6
External Url, 24
Field, 36
Flush a Cache Section, 42
Font Color, 38
Font Family, 38
Font Properties Section, 38
Font Size, 38
Font Style, 38
Font Variant, 38
Font Weight, 38
Form - Record Add, 6
Form - Record View, 6
Form Properties Section, 25
Form Section, 25
Form Styles, 34
General Properties Section, 40
GIF Banner, 40, 41
Green Skin, 44
Group Overrides, 20
Group Overrides Editor, 21
Group Target Details Section, 21
Height, 40
Hide a Navigation Item from a Group, 20
Hide From Group, 21
Home, 4
IBM TRIRIGA Objects, 34, 41, 42
Icon Details Section, 24
Import, 43
index.html, 2
Item Details Section, 23
Label Style Class, 35
Letter Spacing, 39
Line Height, 39
logo.bmp, 44
Manager, 34
Margin-Bottom, 37
Margin-Left, 37
Margin-Right, 37
Margin-Top, 37
Master/Detail Default Query, 25
Master/Detail Hierarchy, 25
Master/Detail Query, 25
My Calendar, 25
My Profile, 25
My Timesheet, 26
Navigation Builder, 15
Navigation Collection, 15
Navigation Collection Properties Section, 17
Navigation Collection Type, 17
Navigation Item, 15, 21
Navigation Item Editor, 27
Navigation Items Library, 18, 21
Navigation Items Tab, 28
Navigation Target, 16
Padding-Bottom, 37
Padding-Left, 37
Padding-Right, 37
Padding-Top, 37
Portal, 26, 34
Portal Builder, 5, 12
Portal Layout, 12
Portal Layout Tab, 12
Portal Logo, 42
Portal Properties Section, 12
Portal Section, 6
Portal Section Form, 7
Portal Section Types, 6, 8
Portal Sections Library, 6, 12, 13
Position, 40
Pre-Create Workflow Section, 26
Property Section, 37
Query Section, 25
Quick Links, 6
Rearrange Portal Sections, 13
Record Add, 26
Record Open, 26
Related Portal Sections Tab, 12, 14
Remove a Portal Section, 14
Report, 6, 26
Rich Text Editor Styles, 34
Scorecard, 6, 26
Section, 36
Special Views Section, 25
Style Class, 35
Style Manager, 33
Style Names, 35
Style Sheet Editor, 35
STYLE_SHEET.xml, 43
System Manager, 3
System Portal Sections, 6
Tab, 36
Target, 16
Target Details Section, 24, 25
Target Name Section, 25, 26
Target Title, 24
Target Type, 24
Text Properties Section, 39
Text-Align, 39
Text-Decoration, 39
Text-Indent, 39
Type, 35
Use Value, 33
View Color Banner, 34, 42
View GIF Banner, 34, 41
Visibility, 40
Visual Components Section, 33, 34
Where Used Section, 26
Width, 40
Wizard, 34
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

**Privacy Policy Considerations**

IBM Software products, including software as service solutions, ("Software Offerings") may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user or for other purposes. In many cases no personally identifiable information is collected by the Software Offerings. Some of our Software Offerings can help enable you to collect personally identifiable information. If this Software Offering uses cookies to collect personally identifiable information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect personally identifiable information from end users via cookies and other technologies, you should seek...
your own legal advice about any laws applicable to such data collection, including any requirements for notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, see IBM’s Privacy Policy at www.ibm.com/privacy and IBM’s Online Privacy Statement at www.ibm.com/privacy/details in the section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM Software Products and Software-as-a-Service Privacy Statement” at www.ibm.com/software/info/product-privacy/.

**Trademarks**

IBM, the IBM logo, ibm.com, and TRIRIGA are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.